
9.2 WCG Eligibility Process 

Purpose: To step through the Washington College Grant eligibility process using ctcLink. 

Audience:  Financial Aid staff. 

This document works through the step-by-step process for the entire WCG Eligibility 

process.  Steps are as follows: 

Step 1)  Select WCG Students using Population Update Process 

Step 2)  Calculate Eligibility for WCG-Eligible Students 

Step 3)  Optional - Review Eligibility View Page 

Step 4)  Run Archive Outbound Process 

*Step 5)  Load WSAC's Archive Inbound File 

*Step 6)  Run a Query to View Eligibility Messages from Archive Process 

Step 7)  Optional - Run Eligibility Lock in Batch 

*Note-- if testing this process, you will not be able to test running Archive Inbound (Step 5 - 

6) 

 You must have at least one of these local college managed security roles: 

• ZD FA SNG Eligibility 

• ZD SACR Financial Aid Config 

• ZZ FA WCG Eligibility 

If you need assistance with the above security roles, please contact your local college 

supervisor or IT Admin to request role access. 
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Washington College Grant Eligibility Process 

 Prior to creating and populating the WCG eligibility page, the following processes must 

occur: 

1. ISIRs need to be loaded 

2. FA Term records built 

3. Student budgets assigned 

Load ISIRs - WCG Population/Update 

 Step 1, WCG Population Update, loads data into the SNG eligibility table. 

Navigation:  NavBar > Navigator > Financial Aid > CTC Custom > CTC Interfaces > WA 
College Grant > WCG Population/Update 

1. The WCG Population/Update search page displays. 
2. Enter an existing or Add A New Value for the Run Control ID. 
3. Select the Search button. 

4. The WCG Populate/Update page displays.  
5. From the Selection Tool drop-down list choose PS Query. 
6. From the Query Name drop-down list choose: CTC_FA_SNG_POPULATE. 
7. Select the Edit Prompts Link. 
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8. The Query Prompts pagelet displays.  
9. Enter the Institution. 

10. Enter the Aid Yr. 
11. Select the OK button. 

12. The WCG Populate/Update page displays. 
13. In the Parameters group box, enter the Academic Institution. 
14. Enter the Aid Year. 
15. *Optional -- Before running the process, you may check your results using the Preview 

Selection Results link. 
16. Select the Run button. 
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17. The Process Scheduler Request page displays. 
18. Select the OK button. 
19. The WCG Populate/Update page displays. 
20. Select the Process Monitor link. 
21. The Process List tab displays on the Process Monitor page. 
22. Select the Refresh button.  
23. The process Run Status should be Success and the Distribution Status should be Posted. 

WCG Eligibility Update 

 The second step is the WCG Eligibility process which moves the data from the SNG 

Eligibility table and updates the eligibility fields on the WCG Eligibility page accordingly. 

 

Begin by navigating to the Calculate WCG Eligibility page. 

 You must have at least one of these local college managed security roles: 

• ZD FA SNG Eligibility 

• ZZ FA WCG Eligibility 
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If you need assistance with the above security roles, please contact your local college 

supervisor or IT Admin to request role access. 

Navigation:  NavBar > Navigator > Financial Aid > CTC Custom > CTC Interfaces > WA 
College Grant > Calculate WCG Eligibility 

1. The WCG Calculate Eligibility search page displays. 
2. Enter an existing or Add A New Value for the Run Control ID. 
3. Select the Search button. 

4. The WCG Eligibility Update page displays.  
5. Select the Selection Tool field and select PS Query from the drop-down list. 
6. Select the Query Name field and choose the desired value from the list. 
7. Select the Edit Prompts Link. 

 The Academic Institution field in the Parameters section must be filled in for Edit 

Prompts link to open on the page.  You cannot run the process without defining the 

Edit Prompts. 
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8. The Query Prompts pagelet displays.  
9. Enter the Institution value. 

10. Enter the Aid Year value. 
11. Select the OK button. 

12. The WCG Eligibility Update page displays. 
13. Confirm that the Parameters section has been fully populated. 
14. Select the Run button. 
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15. The Process Scheduler Request page displays.  
16. Select the OK button. 

17. The WCG Eligibility Update page displays. 
18. Select the Process Monitor link. 
19. Select the Refresh Button. 
20. Check the Run Status of the Process Instance number assigned in previous step. 
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Optional - Verify WCG Eligibility View 

 To verify that the WCG Eligibility View component was populated, navigate to: 

 You must have at least one of these local college managed security roles: 

• ZD FA SNG Eligibility 

• ZZ FA WCG Eligibility 

If you need assistance with the above security roles, please contact your local college 

supervisor or IT Admin to request role access. 

Navigation:  NavBar > Navigator > Financial Aid > CTC Custom > CTC Interfaces > WA 
College Grant > WCG Eligibility View > WCG Elig and Archive Data 

1. The WCG Eligibility Data page displays.  
2. Enter Academic Institution and Aid Year. 
3. Select the Search button. 

4. Search Results are displayed.  
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5. Select a student record from the list.  Verify that data is populated in all the fields. The 
Residency Date field may not be populated, especially if the Residency Prior field is 
populated with Yes. 

6. Verify that if the Eligible? field is populated with Yes, the MFI Percent Calculation and WCG 
Award Amount fields are present and populated and "All conditions have been met. 
 Student is eligible" text is displayed in the Message field box. 

7. If the Eligible? = No, verify that the MFI Percent calculation and WCG Award Amount 
fields are not displayed and there is a reason text in the Message field box. 

8. Verify that the Lock Eligibility Override checkbox is NOT checked. 
9. Select the Next in List button to scroll through multiple student records to review the 

different data values being populated into the fields. 

WCG Archive Outbound 

 WCG Archive Outbound process generates a list of SSNs.  Begin by navigating to the 

WCG Archive Outbound page. 

 You must have at least one of these local college managed security roles: 

• ZD FA SNG Eligibility 

• ZZ FA WCG Eligibility 
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If you need assistance with the above security roles, please contact your local college 

supervisor or IT Admin to request role access. 

Navigation:  NavBar > Navigator > Financial Aid > CTC Custom > CTC Interfaces > WA 
College Grant > WCG Archive Outbound 

1. The WCG Archive Outbound search page displays.  
2. Enter an existing or Add A New Value for the Run Control ID. 
3. Select the Search button. 

4. The WCG Archive Outbound page displays.  
5. Select the Academic Institution list and choose the desired value from the list item. 
6. Select the Aid year list and choose the desired value from the list item. 
7. Perform the appropriate selection for the Select Eligibility box. 
8. Select the Run button. 
9. The Process Scheduler Request page displays. 

10. Select the OK button. 
11. The WCG Archive Outbound page displays. 
12. Select the Process Monitor link. 
13. The Process Monitor page displays. 
14. Select the Refresh button.  Check the Run Status of the Process Instance number assigned 

in prior step.  
15. Once process status is shown as success and distribution statuses as posted, select the 

Details link. 
16. The Details page displays. 
17. Select the View Log/Trace link. 
18. The View Log/Trace page displays. 
19. Select the applicable file name.  
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20. Carefully copy all the SSNs listed in the file.  
21. Paste the list of SSNs into a new NotePad document. 
22. Save the file onto your desktop with an appropriate file name (any file name will be 

sufficient). The format of the file should be saved as a .txt file. 

 Process the file you just saved into the WSAC WCG Archive Cruncher. 

Once you process the file through the WCG Archive Cruncher, DO NOT open the file. 

Instead, save it directly to your desktop. Again, any file name will be sufficient. The 

format of the file should remain as .csv. (This is to eliminate having SSNs with leading 

zeros drop off in the file; which would result in an error during processing.) 

Before proceeding with the WCG Archive Inbound process, be sure that the prior steps 

have been completed and you have access to the file you saved from the WCG Archive 

Cruncher. 

WCG Archive Import 

 WCG Archive import process loads data from the Cruncher file into the archive import 

table. Begin by navigating to the WCG Archive Import  page. 
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 You must have at least one of these local college managed security roles: 

• ZZ FA WCG Eligibility 

If you need assistance with the above security roles, please contact your local college 

supervisor or IT Admin to request role access. 

Navigation:  NavBar > Navigator > Financial Aid > CTC Custom > CTC Interfaces > WA 
College Grant > WCG Archive Import 

1. The WCG Archive Import search page displays.  
2. Enter an existing or Add A New Value for the Run Control ID. 
3. Select the Search or Add button. 

4. The WCG Archive Inbound page displays.  
5. Select the Selection Tool list and choose the desired value from the list item. 
6. Select the Upload File button. 
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7. The File Attachment pagelet displays. 
8. Select the Browse button - Browse for and select the file you received and saved from the 

WSAC WCG Archive Cruncher - Depending on the browser, select the Open button. 
9. Select the Upload button. 

10. The WCG Archive Inbound page displays. 
11. Select the View File button to verify that the file uploaded has the correct data. 
12. Select the File mapping field - select the SNG ARCHIVE INBOUND value from the list item. 
13. Select the Preview Selection Results to view data from within the file and how it will 

populate into the mapped fields. 
14. Select the Return button. 
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15. The WCG Archive Inbound page displays. 
16. Enter the Academic Institution. 
17. Enter the Aid Year. 
18. Select the Run button. 

19. The Process Scheduler Request page displays. 
20. Select the OK button. 
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21. The WCG Archive Inbound page displays. 
22. Select the Process Monitor link. 

23. The Process Monitor page displays. 
24. Select the Refresh Button. 
25. Check the Run Status of the Process Instance until Run Status is Success and 

Distribution Status is Posted. 
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Optional:  Verify Eligibility Messages 

 You can view the Archive Inbound eligibility messages on each WCG student by running 

a query.  Navigate to the Query Viewer. 

 You must have at least one of these local college managed security roles: 

• ZD_DS_QUERY_VIEWER 

If you need assistance with the above security roles, please contact your local college 

supervisor or IT Admin to request role access. 

Navigation:  NavBar > Navigator > Reporting Tools > Query > Query Viewer 

1. The Query Viewer search page displays. 
2. Enter Query Name in the query name field:   CTC_FA_SNG_ALL_RECORDS 
3. Select the Search button. 
4. The Search Results display. 
5. Select the HTML link under the Run to HTML column. 
6. The Query page displays. 
7. Enter value in the Institution field. 
8. Select View Results button. 
9. The Results page displays. 

10. Select the Excel Spreadsheet link. 
11. Select the Open with radio button and select Excel. 
12. Review and compare data in the query spreadsheet against data in the original file from the 

WSAC Cruncher results. Verify the data populated in the corresponding fields.  Tip!--Filter 
the message column by Not Eligible due to no remaining quarters, and Not Eligible due 
to Repayment Status. 

13. Also review the results under Special Processing and verify that the mentioned fields are 
updated appropriately. 

WCG Eligibility Data 

 To test making manual changes on WCG Eligibility Data page and manually 

calculating the students' WCG eligibility, use the Calculate button on the WCG 

Eligibility and Archive Data page. 
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 You must have at least one of these local college managed security roles: 

• ZD FA SNG Eligibility 

• ZD FA WCG Eligibility 

If you need assistance with the above security roles, please contact your local college 

supervisor or IT Admin to request role access. 

Navigation:  NavBar > Navigator > Financial Aid > CTC Custom > CTC Interfaces > WA 
College Grant > WCG Eligibility View > WCG Elig and Archive Data 

1. The WCG Eligibility Data search page displays.  
2. Enter the ID. 
3. Enter the Academic Institution. 
4. Enter the Aid Year. 
5. Select the Search button. 

6. Select [+] button to add a row. 
7. In this example, you can change the student's eligibility -- as a scenario example, if you 

determined this student is truly an out-of-state resident.  In this scenario example, enter OR 
(Oregon) into the State of Residency field. 

8. Select the Calculate button -- note the eligibility changes. 
9. Repeat steps for the remaining scenarios as needed. 
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WCG Override Process 

 WCG Override process overrides the Lock Eligibility Override field on the WCG 

Eligible Data page for the students selected.  Begin by navigating to the WCG Override 

Process page. 

Navigation:  NavBar > Navigator > Financial Aid > CTC Custom > CTC Interfaces > WA 
College Grant > WCG Override Process 

1. The WCG Override process search page displays. 
2. Enter an existing or Add A New Value for the Run Control ID. 
3. Select the Search button. 
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4. The WCG Override Process page displays.  
5. Select the Selection Tool and choose the desired value from the list item. 
6. Select the Query Name list and choose the desired value from the list item. 
7. Select the Edit prompts link. 

8. The Query Prompts pagelet displays.  
9. Enter the Academic Institution. 

10. Enter the Aid Year list. 
11. Select the desired value from the Item Type list -- in this example, we want to process an 

override lock determination on the Washington College Grant Item Type. 
12. Select the desired value from the Eligible list -- in this example, we want to override lock 

determination on all Yes eligible.  
13. Select OK button. 
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14. The WCG Override Process page displays. 
15. Select Preview Selection results. 
16. The results display.  
17. Select the Return button. 
18. The WCG Override Process page displays. 
19. Enter the Academic Institution. 
20. Enter the Aid Year. 
21. Select Lock Eligibility checkbox. 
22. Select Run button. 

23. The Process Scheduler Request page displays. 
24. Select the OK button. 
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25. The WCG Override Process page displays. 
26. Select the Process Monitor link. 

27. The Process Monitor page displays. 
28. Select the Refresh button.  
29. The Run Status should be Success, and the Distribution Status should be Posted. 
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Optional:  Verify That the WCG Eligibility Data Page Was Updated 

 You must have at least one of these local college managed security roles: 

• ZD FA SNG Eligibility 

• ZZ FA WCG Eligibility 

If you need assistance with the above security roles, please contact your local college 

supervisor or IT Admin to request role access. 

Navigation:  NavBar > Navigator > Financial Aid > CTC Custom > CTC Interfaces > WA 
College Grant > WCG Eligibility View > WCG Elig and Archive Data 

1. Using the list of student IDs from the verify eligibility messages step (Query Viewer), access 
the student's data in the WCG Eligibility and Archive Data page. 

2. Verify that the Lock Eligibility Override checkbox is updated accordingly. 

WCG Setup 

 In order to properly test the recalculation of WCG eligibility for all students who already 

have a WCG eligibility page, you must first make sure the WCG Setup Table has been 

updated to different values than what was used when the WCG eligibility processes 

were run the first time. 

 You must have at least one of these local college managed security roles: 

• ZC FA Local Configuration 

• ZD FA Local Configuration 

• ZD SACR Financial Aid Config 

If you need assistance with the above security roles, please contact your local college 

supervisor or IT Admin to request role access. 

Navigation:  Nav Bar > Navigator > Set Up SACR > Product Related > Financial Aid > CTC 
Custom > CTC Interfaces > WA College Grant > WCG Setup 

1. The WCG Awards Setup search page displays.  
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2. Enter Academic Institution. 
3. Enter Aid Year. 
4. Select the Search button. 

5. The Award Amounts Table tab displays.  
6. To test the fields on this page, you can update NonBas Award Amount in the first row (MFI 

percent = 50). 
7. Select the Save button. 
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WCG Populate/Update Process 

Once the WCG Setup has been updated, run the WCG populate/update process. 

 You must have at least one of these local college managed security roles: 

• ZD FA SNG Eligibility 

• ZD SACR Financial Aid Config 

• ZZ FA WCG Eligibility 

If you need assistance with the above security roles, please contact your local college 

supervisor or IT Admin to request role access. 

Navigation:  NavBar > Navigator > Financial Aid > CTC Custom > CTC Interfaces > WA 
College Grant > WCG Population/Update 

1. The WCG Populate/Update search page displays.  
2. Enter an existing or Add A New Value for the Run Control ID. 
3. Select the Search or Add button.  

4. The WCG Populate/Update page displays.  
5. Select the PS Query value from the Selection Tool drop-down list. 
6. Select the Query Name field and enter the desired value from the list. 
7. Select the Edit Prompts link. 
8. The Edit Prompts pagelet displays. 
9. Complete the available fields. 
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10. Select OK to close the pagelet. 
11. The WCG Populate/Update page displays. 
12. In the Parameters group box, select the Academic Institution. 
13. Enter the Aid Year. 
14. Select the Recalculate checkbox. 
15. Select the Run button. 

16. The Process Scheduler Request page displays. 
17. Verify that the E:008 SNG Population/Update Process checkbox is selected. 
18. Select the OK button. 

19. The WCG Populate/Update page displays. 
20. Select the Process Monitor link. 
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21. The Process Monitor page displays. 
22. Select the Refresh button. 
23. Check the Run Status of the Process Instance number assigned in previous step. 

 In order for the recalculated data to populate on the student's WCG Eligibility page, 

you must now run the Calculate WCG Eligibility process. Go to Calculate WCG 

Eligibility section of this QRG to refer to instructions to run that process. 

Optional:  Verify Student Award Amount 

 Verify that the process recalculated the students award amounts. 

 You must have at least one of these local college managed security roles: 

• ZD FA SNG Eligibility 

• ZZ FA WCG Eligibility 

If you need assistance with the above security roles, please contact your local college 

supervisor or IT Admin to request role access. 
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Navigation:  NavBar > Navigator > Financial Aid > CTC Custom > CTC Interfaces > WA 
College Grant > WCG Eligibility View > WCG Elig and Archive Data 

1. The WCG Eligibility Data search page displays. 
2. Enter Academic Institution. 
3. Enter Aid Year. 
4. Select the Include History checkbox. 
5. Select the Search button. 

6. The Search Results portion of the page displays.  
7. Select a student from the list. 
8. Select Search. 
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9. Once on the WCG Eligible Data tab, check to see that the MFI Percent Calculation field 
contains correct value. 

10. If so, check that the WCG Award Amount was updated correctly. 
11. Go to a previous row to review what the award amount was before the recalculation. 
12. If the MFI Percent Calculation field contains a value other than expected, select on the 

Next In List button at the bottom of the page until you find a student with the desired 
value. 
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13. Processes complete. 
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